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Introduction to General Concepts of Trading Systems  
and Their Implementation in VTtrader 

 
 

 Looking further into the building of proprietary indicators and oscillators, many traders have a need to 
combine them into certain strategies or systems and use them as recommendations for trading.  
 

Many traders would like to create proprietary trading systems that provide easily understandable 
signals for action, in accordance with clearly defined and previously confirmed logical formulas, free of 
emotional influences and poor decisions. This problem is familiar to anyone with even modest trading 
experience in the financial markets.  

 
VTtrader  offers users just such a possibility. One of the most remarkable aspects is that the trading 

systems created in VTtrader  can not only provide recommendations in accordance with your proprietary 
logical formula, but can also be used to place trades automatically. This means that you need only observe 
and manage the process from time to time. 

 
The basic concept of the Trading System Builder is: 
 
The Required Situation and the Point of Necessary Action appear in the market only if a certain 

condition is met. A given condition can always be described with the language built into VTtrader.  If this 
condition becomes true or false at a certain time, then the action associated with given condition may be taken 
and the Situation itself reflected. 

  
 
 
 
 
Therefore, the main task of the user is to determine and describe the necessary condition (or a 

combination of conditions required to take action) and assign certain actions to it. The condition itself will be 
described with the help of the language built into VTtrader  (see VTtrader Help Manual (Version 1)), and may 
be either true or false. Depending on the state of the condition, the associated action is either taken or not 
taken. 

 
 

Condition Action 

Action Taken 

Action  

� ondition 

False  True 

No Action Taken 
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Action Action 
 

Condition Condition 

Trading System 

Type   Type Type Type 

What exactly is meant by action? Therein lays the main issue in developing a trading system (TS). The 
actions of the TS must generate signals on the chart, depending on the state of the market, that are based on 
the user’s requirements and must designate and report optimum calculated points for taking action. The user 
can either manually accept the suggested action using TS signals as recommendations, or switch the Trading 
System into automated trading mode, resulting in the system itself placing trades based on the formula created 
by the user.  

 
Currently all actions may be categorized as being one of the following types: 
 
 1.   Visual reflection  
  
The required signals in accordance with the user’s formula are immediately reflected on the price chart. 

In this type, colored markings or special symbols can be used. It is also possible for an entire region on the 
chart to be marked. As a general rule, this category of reflection is used as a recommendation-type action or in 
conjunction with other types of actions.               

 
2.   Text and sound alerts 

 
In this case the Trading System, in accordance with the user’s specification, can alert to a particular 

trading situation, either visually by flashing a text message in the Activity Window and/or via a sound alert.  
 
 3. Error message 
 
An error message warns about improperly entered parameters into the Trading System that are 

inconsistent with the formula of calculations and may result in wrong actions in decision-making. Such an 
action provides a message and sound alert, but also suspends the operation of the Trading System, requesting 
the user to change the entered parameters.  

 
4. Action involving real trading operations 

 
This type of action is perhaps the most important. After describing the formula for operations, the user 

might want to view how the Trading System buys or sells at appropriate points. It is highly recommended that 
you control this process from time to time and make sure the trading platform is securely connected to the data 
server. This type of action is designated only for the Auto trading mode and may be switched off at any time.  

 
Clearly, the first three types of actions serve the purpose of reflecting, one way or another, the signals 

as recommendations. Only the last type is used in the real Auto trading mode. All actions may work separately 
from each other or together and, moreover, different actions may be described by one and the same condition. 
In other words, one condition might be assigned several actions.  
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This concept of the Trading System Builder opens up the possibility of a flexible approach to creating 
and taking full advantage of the Trading Systems in VTtrader . Before building and implementing a trading 
system, it is recommended that the user fully read the VTtrader Help Manual paying particular attention to the 
sections about the Indicator Builder and the VTtrader Programming Language; these sections will help build a 
solid foundation on which you will be e abadd to to your knowledge and understanding of what VTtrader  is 
capable of in regards the the creation of indicators and their utilization in trading systems. We assume that 
the user is fully aware of the formulae for the desired actions required from the Trading System, and 
the VTtrader platform will only assist in this endeavor. 

2. What is the Trading System Builder? 
 

The Trading System Builder is a powerful instrument for creating Trading Systems. However, in order 
to use it effectively one must understand the principles of building such systems, and how they must be 
implemented within the platform that has been chosen for that purpose. If you are at least somewhat familiar 
with writing formulas for spreadsheet table programs and have tried to create proprietary indicators or 
oscillators in VTtrader  with the help of Indicator Builder, you should experience little difficulty in mastering 
formulas allowing you to start developing your own trading systems immediately.  

 
The systems that you create are automatically saved in VTtrader  so there is no need to re-enter them 

each time you wish to employ them.  
 
VTtrader  is structured in such a way as to provide maximum convenience to anyone using and 

managing trading systems. It consists of a combination of three components each responsible for its own 
sector of activities. Even the simplest system must first be created, and then stored somewhere, copied, 
moved and exported if necessary. Secondly, it is necessary to write down and edit the trading system formula 
(logic) itself. And, thirdly, you must be able to start the trading system, attach it to the trading chart and manage 
the system in a real environment. 

  
In order to clearly understand the structure and the principles of developing systems in VTtrader , users 

should thoroughly study this manual. We hope that our efforts will result in your understanding how to move 
from the development of the concept of the Trading System to its practical functionality.  

 

3. Trading System Builder: Step-by-Step approach 
 

Setting the Tasks. Preparation for Work. 

 
Before we start our work it is necessary to define how and according to what formula the system under 

development should function. However, since this manual is aimed at teaching the user not only the principles 
of creating the right systems, but empowering him/her with the ability to put his/her designs into practice, let us 
take a simple, logical and easily understandable formula as an example.  

 
While reading certain books you have probably come across different systems proposed by different 

authors. Let us take as an example a rather simple Trading System and make it function on the VTtrader 
platform, using the recommendations of its author.  

 
Below, you will see parts of a letter from the author of such a system taken from an internet website. In 

the letter the author proposes using an RSI oscillator smoothed by moving averages with different parameters 
(in particular, exponential 10 and 30 day period MAs). First, read this letter and create the proposed system on 
our platform:  

…………………………………… 
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Anybody tried using TC2000's new moving average based on relative strength in Metastock? 

I developed a good indicator to identify trends in stocks, but TC2000's idea of using a 10 and 30 day 
moving average of relative strength (vs. SP500, NASDAQ,   etc.), works as well or better than mine. Using 
moving averages based on the stocks' relative strength to a broader market average eliminates market 
gyrations from the equation and allows the moving averages to be sensitive only to 
stock performance relative to the index. 

  I programmed this into Metastock by plotting a relative strength indicator in white (making it invisible 
on white background),   and created 2 moving averages based on this indicator (10 and 30 exponential).   
When the 10-day crosses above the 30 day, this is assumed to be bullish, and   you look to be bearish when it 
crosses back below the 30-day line.  Obviously,   the two moving averages can be any number, but these 
seem to work well. 
 

I tested this setup on many NASDAQ stocks by   programming an expert with my indicators (not 
TC2000) and comparing the trend changes to mine visually, and saw that they were very similar. My system is 
very accurate for finding trends, and entry points, so I'm assuming this TC2000 setup is as reliable.  I haven't 
found a way yet to program relative strength into a system test, so if anybody knows how I'd appreciate 
learning the secret.  I used the SP-500 as the comparison to NASDAQ stocks because it correlates well with 
the NASDAQ, but isn't as volatile. 
 

My trading system only uses the trend as one   piece and several other indicators for entry and exit, but 
I believe this indicator is as close to perfect for determining trends as you'll find. 
 

Dave D. 
 

………………………………….. 
 
 So, the letter’s author, let’s call him Dave, proposes to plot 10 and 30 day moving averages (MoV) 
based on the Relative Strength Index (RSI) and use their crossovers as signals to enter the market. If the 
faster 10 day MoV crosses above the slower 30 day MoV, all short positions, if any, are closed and long 
positions opened. And if the crossover occurs below, all long positions are closed and short positions opened.  

 
Note: 
To avoid accidental opening of positions on real accounts, we strongly advise you to conduct all 

activities and testing of Trading Systems on demo accounts. 
 
After we have outlined the task, please start the trading platform in demo mode, select and open a new 

chart. To avoid any confusion, open a one hour EUR/USD chart and erase all indicators and oscillators from it.  
 
Everything is ready for work. 
 

 
First, plot the Moving Average of RSI 

indicator (included with VTtrader) on the chart. 
Pay attention to the label. Here, parameters are 
reflected that were specified in the process of 
bringing the indicator into the price chart. 

 
Carefully evaluate this indicator, 

especially the red/blue line crossovers, as they 
relate to the price movement. 
According to Dave, the author of the original 
letter, long positions should be taken when the 
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red line crosses over the blue one and short positions should be taken when the red line crosses under the 
blue line.  
 Judging from experience, one should understand that any indicator or oscillator provides a more 
precise reading if applied to large scale price movements, because on a smaller scale price movement is 
subject to a greater number of fluctuations and indicator parameters have to be adjusted. When we created 
this indicator we left open such a possibility. The author maintained that the trading system was applied to a 
one day chart. However, we were satisfied with the indicator’s reading even on a 2-hour interval chart, but on a 
smaller scale the parameters of this indicator will have to be changed, filtering out the “market noise.” 
  
 Currency pairs and chart scales should be changed. Check the efficiency of such an approach on 
different time intervals. Remember that the purpose of this manual is to teach you how to construct proprietary 
trading strategies on the VTtrader platform. So we will leave the parameters unchanged, proposed by the 
indicator’s author, and create a trading strategy based on its signals and make it work without our involvement.   
  

Step 2. “Edit Trading Systems” Component 
 

In this section, we will learn how to use the “Trading Systems Builder” component. You will begin to 
develop your first trading strategy based on Moving Average of RSI indicator included with VTtrader. 

 
This “Trading Systems Builder” component is responsible for storing trading strategies, moving and 

bringing them up for editing. All of this allows the user to create his/her own trading strategies database, so 
that these strategies are readily available for use at any time.   

 
 
Therefore, strategies developed with the Trading System 

Builder  can be edited, moved, deleted or exported/imported at any 
time through the Trading Strategies Editor that can be brought up 
from the VT Navigator window.  
 
 

VT Navigator -> Tools -> Trading Systems Builder -> 
-> Trading Systems Builder … 

 
Bring up the editor from the Navigator panel.  

 
 
 

 
 

The “Trading Systems Builder” window helps  
to manage the structure of the Trading Strategies 
represented. 

 
 On the left side we see a set of trading systems 
 created by the user or supplied together with VTtrader , 
 and on the right side of the same window are the  
 controlling buttons. 
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- The “NEW” button allows the user to begin developing a unique new system. When pressed, 
this button brings up a special window called “Studies Editor” that is used for the purpose of 

editing trading systems. 
 
- The “EDIT” button brings up a special window called “Studies Editor” that is used for editing 
the Trading System that was selected with the cursor when the “EDIT” button was clicked. 

 
- The “CLONE ” button allows the user to copy the system selected with the cursor and brings 
up a special window called “Studies Editor” for editing the Trading System that was copied.  

 
- The “DELETE ” button removes the system that was selected if protection against deletion 
was removed in the options menu. This issue will be dealt with in more detail below. By 

default, all Trading Systems are protected against accidental deletion, and the “DELETE ” button will be 
highlighted only if the user manually removes protection in system properties by bringing up a special window 
called “Studies Editor” by clicking the “EDIT” button. 
 

- The “EXPORT ” and “IMPORT ” buttons are used respectively for exporting and importing 
built-in, as well as newly created, systems. This ensures flexibility when exchanging trading 
systems or storing them separately. 
 

 
- The “CLOSE ” button closes the window.  
 

 
Do not close the Trading Strategies editor. Click the “New” button to create a new strategy and bring up the 
Studies Editor component.  
 

Edit Trading Systems -> NEW -> Studies Editor… 
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Step 3. “Studies Editor” Component and Development o f Trading Strategy 
 
 
 This component allows the user to develop and directly edit the Trading System. It is brought up from 
the “Trading Systems Builder” component by clicking the “New,” ”Edit” or ”Clone” button depending on the 
user’s intention: 
 

VT Navigator -> Tools -> 
Trading Systems Builder -> Trading Systems Builder -> NEW… (EDIT, CLONE) 

 
 The component consists of four tabs. Since you now know how to create indicators, many things here 
will be familiar to you. Each of the tabs has its own function, but all of them belong only to the properties of the 
Trading Strategy that is created or edited. 
 

 
  The “Studies” tab   
This specifies the general properties of the strategy that is 

developed by the user. 
  

 
   

Fill in the “Name” with the system’s unique name that will be later reflected in the left part 
of the “Edit Trading Systems” component. 

 
  Name -> Moving Average of Relative Strength System  

 
 
 

 
The “Short Name” is necessary to identify the trading system within the entire VTtrader 
platform. At this stage there is no short name being used, but we will fill in “MARSS” 

(abbreviated from Moving Average of Relative Strength System). The name is entered without spaces and 
punctuation marks, just using letters and numbers. 
 

Short Name -> MARSS 

     Click the “OK” button.       
 

Make sure you can see the strategy name in the “Edit Trading System” window. 
 
 
 
 
 
 
 

 Select the trading strategy name with the cursor and bring it up for editing by clicking the “Edit” button: 
 

Edit Trading System-> EDIT-> Studies Editor 
 

Continue editing the Trading Strategy. 
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“Label Mask” is used to specify variables separated by the % sign in order to take into 
account the values of these variables when the strategy’s formula is calculated. For 

now, leave this space blank. We will return to this issue when the system is ready.  
 
 “Real-Time” specifies the frequency of the re-calculation of the trading strategy’s results. When “Complete 
Bar” option is chosen, the system will make decisions and provide results only after the price bar of the interval 
used by the Trading Strategy is completely formed. “Complete Bar” mode is currently the only mode of 
operation available in VTtrader.  

 
The checked box next to the “Indicator Lock” option protects against accidental deletion of 
your trading strategy from the VTtrader system. If the box is unchecked, the “Delete” button 

on the “Edit Trading Systems” component is activated and the trading strategy can be deleted.  
 

Indicator Lock -> On 
 

The “Notes” field is used to describe a given strategy. The entered data is not 
reflected anywhere in the system and is not used for anything else. You can type 
in anything you like or leave this field empty. 
 

 
You have the option of setting a password for your trading strategy. To 
set a password, enter it into the “Password” and “Confirm Password” 
spaces. Keep in mind that passwords are case sensitive. The next time 
you bring up your trading strategy for editing, the VTtrader system will 

require you to enter the password that you selected. Thus, you will be able to hide the principles and formulas 
of your strategy. The password protection feature remains in place when importing or exporting the trading 
strategy. For now, leave the password option blank. 
 

In order to designate the names and types of variables that would be entered for the purpose of 
calculating the strategy’s formula and categories of its actions, click on the “Formula” tab. 

 
The “Formula” tab  

 
The main purpose of the “Formula” tab is to allow the 
user to describe the logical and mathematical formulas 
that will form the base for taking the desired actions: 
  

Studies Editor->Formula 
 

  The strategy that is being developed is based on the Moving Average of Relative Strength Index 
indicator that you’ve just created and refers to the position of the two RSI moving averages next to each other: 
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According to the author’s recommendation, whenever MA1 crossover occurs above MA2 (that is 
precisely the required condition) it is necessary to assume long positions, and when the crossover occurs 
below (again, the necessary condition) a short position should be taken. 

 
It is necessary to “explain” this to your trading strategy. It should be understood that although the 

VTtrader system understands only the language of mathematics and logic, it will do exactly what you will tell it 
to do. To write the strategy’s script we recommend using any standard Windows word processor (for example 
Notepad). Then use the “Copy” function to insert what you wrote into the “Formula” field. Be generous when 
writing commentaries inside the brackets. 

 
The value of RSI is used directly in the calculations. Copy and paste it into the formula of calculations in 

Notepad or straight into the “Formula” field. It is directly involved in the calculations: 
 
 { Relative Strength Index} 
 
 RSI_r:= (CLOSE - ref(CLOSE,-1));  
 RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) / Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
 RS:= 100-(100/(1+rsi_rs)); 

 
It is not necessary for you to understand this formula at this stage. Accept it as it is. Just copy and paste 

it. (If you are interested in knowing exactly how this oscillator works, we recommend that you read books on 
this subject.) Rather than rewriting the formula, we could instead have referred directly to it using its 
identification number, which can be seen if you bring any indicator in the “Short Name” column for editing. But, 
to avoid confusion and facilitate finding mistakes, it is recommended that when creating the system you rewrite 
all elements involving calculation. We intentionally made the RSI period equal to 14, and we will later introduce 
changes into this approach, so that the parameter could be specified whenever the system is used. 
  

The calculations make use of the RSI moving averages, and this too must be indicated in the Strategy’s 
script. Copy and paste the text below:  
 
  {Moving Average of Relative Strength Index} 
 

MA1:=MOV (RS, 10, E); 
MA2:=MOV (RS, 30, E); 

 
  By now you have specified all preliminary elements required for action.   
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The Strategy already “knows” what to calculate, but has no idea what to do with the results. In order to 
make it undertake some actions, it is necessary to define a certain variable, set a condition for it, and if this 
condition turns out to be true, have the strategy implement the designated action. 

 
 All of the variables mentioned above are not logical by nature. A logical variable can only assume one 

of two values, such as “true” or “false”, zero or 1. At any time it can have only one stable state. 
  
 Per the strategy, we will let the system give out a signal when it is required to open a long or short 
position. Because we make an estimate of the fact that the MA1 and MA2 crossover occurred and are not 
interested in knowing what has greater or lesser value, it makes sense to use the built-in function of the 
VTtrader CROSS language: 
 

SYNTAX cross (DATA ARRAY 1, DATA ARRAY 2) 
FUNCTION Plots a "+1" on the day that DATA ARRAY 1 crosses above DATA ARRAY 2.  Otherwise, 

"0" is plotted. 
If you want to know when DATA ARRAY 1 crosses below DATA ARRAY 2, use the 
formula "cross (DATA ARRAY 2, DATA ARRAY 1)" 

EXAMPLE cross (close, mov (close, 9, e)) 
 

We’ll use this as a foundation to create two variables such as LONG and SHORT.  Copy and paste the 
text below into the strategy’s script:  

 
{Signal Long and Short} 
 
Long:= CROSS (MA1, MA2); 
Short:= CROSS (MA2, MA1); 

 
It is worthwhile to note the advantage of the CROSS function, which dictates that it always equals zero, 

except in the case of crossover of the two values, which will generate a 1.  
 
We used the expression: Long:= CROSS (MA1, MA2). This orders the system to compare MA1 and 

MA2 values with one another at all times, while assigning the Long variable the value equal to 1 only at points 
when MA1 becomes greater than MA2; the rest of the time let the Long variable be equal to 0. 

 
We used the expression: Short:= CROSS (MA2, MA1). This orders the system to compare MA1 and 

MA2 values with one another at all times, while assigning the Short variable the value equal to 1 only at points 
when MA1 becomes less than MA2; the rest of the time let the Short variable be equal to 0. 

 
The entire script can be seen by now in the “Formula” field: 
 
{Relative Strength Index} 
 
 RSI_r:= (CLOSE - ref(CLOSE,-1));  
 RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) / Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
 RS:= 100-(100/ (1+rsi_rs)); 
 
 {Moving Average of Relative Strength Index} 
 
 MA1:=MOV (RS, 10, E); 
 MA2:=MOV (RS, 30, E); 
 
 {Signal Long and Short} 
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 Long:= CROSS (MA1, MA2); 
 Short:= CROSS (MA2, MA1); 
 
 We now must specify the type of action to be associated with the Long and Short variables. To 

do this, click on the “Output” tab. 
 

 
Studies Editor-> Output… 

 
 
 

The “Output” tab  
The “Output” tab allows us to indicate precisely to which variables from the strategy’s formula the 

system should react, and precisely what actions it should take if the conditions of this variable are true. 
 
 Follow the path below, and we’ll then comment on them: 
 

Studies Editor-> Output… 
…->New->Output Variable Properties… 

 
The “Output Variable Properties” window serves 

the purpose of specifying the action for the variable and 
directly managing its’ parameters. 
 
 

Next to “Var Name,” indicate the name of the variable to which the system should react: 
 

…->Output Variable Properties->Var Name->LONG 
 
 Try to be precise and indicate properly the names of the variables 
from the formula. The system is indifferent to what you write, but if it 

does not find such a variable it will assume that it is equal to zero and will not take any action. This entry is not 
case-sensitive.  
 
 As a rule, to facilitate the entry of the formula, text abbreviations are used instead of the full names of 
variables. Next to “Name,” write down a phrase that is easy to understand: 

 
…->Output Variable Properties-> Name->Signal LONG 
 

The description of this variable may be entered in the “Description” field.  This field can be left empty. 
 

 
…->Output Variable Properties-> Description -> 

-> Long:= CROSS (MA1, MA2); 
 

The type of action assigned to the variable will be selected by checking the box opposite each available 
option. 

 
The “Graphic Enabled” option brings up a graphic object or sign to the price chart if the 
logic variable is true. The sign’s properties and parameters depicted on the chart are also 

specified under the “Graphic” tab.  
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…->Output Variable Properties-> Graphic … 
 

The “Highlights Enabled” option lets the user choose the desired color for the chart bar 
under the “Highlights” tab, provided the variable is true. 

 
 

…->Output Variable Properties-> Highlights 
 

 
 

 
The “Alerts Enabled” option will turn on a sound alarm and/or bring up a message to the 
screen, depending on the condition of the variable. The alert parameters and the text of the 

message are set out under the tab. 
 

…->Output Variable Properties -> Highlights 
 

 
 
 
 
 
 
 

Depending on the condition of the variable, the “Trading Enabled” option makes it 
possible to give orders to open and close a position in the market. The parameters of 

such actions and the direction of the position itself are indicated under the “Trading” tab. 
 
 
 
 
 
…->Output Variable Properties ->Trading 
 
 

 
 
 

 
Later on, we will discuss this tab in greater detail. As previously mentioned, 

the same variable may be assigned several actions, and the same actions may be 
assigned to different variables. 

 
 For now, turn on the “Graphic Enabled” function under the “Name” tab. .  

 
…->Output Variable Properties ->Name -> Graphic Enable -> 

ON 
 

 With this command, you have assigned the action to the “Long” variable of 
bringing up the symbol to the price action chart. Select the “Graphic” tab and set 
its parameters. 
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…->Output Variable Properties ->Graphic-> 
 

-> Font - > Select Symbol -> 
 
 Select the size and the color that will show up on the screen: 
 

…->Output Variable Properties ->Graphic-> Size -> Medium  ->Color -> Dark Blue  
 
 

 
 
 
 
 
 
  

Also, set the symbol position in relation to the price movement (above price, below price). 
 

 
Graphic -> Below Price Plot-> ON 

 
 
 

Click the “OK” button, but stay on the “Output” window. 
 
At this point, you have assigned an action to the “Long” variable and specified the parameters for it. If 

further changes and additions are deemed necessary to the variable’s actions, the user must bring up the 
“Studies Editor” component from the “Output” window and click the “Edit” button. 

 
Perform the same operations for the “Short” variable: 
 
Studies Editor -> Output -> New -> Output Variable Properties -> Name -> 

 
-> Var Name -> SHORT -> 
-> Name -> Signal SHORT -> 
-> Description -> Short:= CROSS (MA2, MA1); -> 

-> Graphic Enable -> ON -> Output Variable Properties -> Graphic -> Font -> -> 
-> Size -> Medium -> 
-> Color -> Red -> 
-> Above Price Plot -> On -> 
 
-> OK… 
 
Use the “Close” button to close the “Edit Trading System” window.  
 
The development of your strategy is now complete. The strategy can only generate and bring to the 

price chart the arrow signs pointing in the recommended direction of entry into the market according to your 
instructions. 

 
 Later, we will develop this strategy further and “teach” it to do much more, but even in such capacity it 

can be used to produce recommendations for market operations. Regardless of what might happen in the 
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market and what opinions the user adopts, the strategy will remain unbiased and produce absolutely logical 
results that are not subject to any influences. Such an approach reduces the market’s emotional influence on 
the trader. This is the main advantage of creating a proprietary trading strategy for conducting market 
operations. 

 
Step 4. Managing the Strategy’s Launch into Action  

 
Let us now check what we have done. For this purpose we’ll simply apply the strategy that we have 

developed and compare the results with Moving Average of Relative Strength Index indicator that we had 
created earlier, and which serves as the foundation for our strategy. 

 
The VTtrader  platform includes features that make it convenient to launch and manage the trading 

strategy. There are several ways to implement this task, but the simplest and easiest way is to attach the 
strategy to an open price chart by right-clicking on the chart and opening the context menu.  

 
As we did earlier, run VTtrader  in Demo mode and open a EUR/USD 1 hour chart so that it occupies 

the entire screen, with the Moving Average of Relative Strength Index indicator plotted on a separate frame 
underneath the chart.  

 
 
 
 

Your computer screen should look like the example above.  
 
Right-click the mouse on the open chart field, and highlight the “Add Trading System” entry, which will 

include Moving Average of Relative Strength System Trading Strategy that you have created. 
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…Chart EURUSD 1H -> right click -> Add Trading System -> 
-> Moving Average of Relative Strength System 

 
. 
 
 
 
 
 
 
 
 
 
 
Clicking the “OK” button in the “Trading System Properties” window permits us to change the 

parameters directing the signals to default settings. 
 
 
 

-> OK 
 
 
 
 
 

 
If everything was done correctly, you will see graphic symbols, in this case arrows, on the price chart. 
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Moving across the chart, compare the system’s signals to the readings of the indicator plotted below. At 
this point, you should understand where the red and blue arrows come from. If not, stop here and re-read the 
manual up to this point. 

 
You may remove the indicator from the chart, but in this case the system will continue to function and 

generate signals in the background.  
 
If you removed the indicator from the chart, restore it now. We will need it to make comparisons and 

understand how the trading strategy works. 
 
It is really advantageous that the strategy operates completely automatically and generates signals 

based on the conditions that you set yourself. The signals are plotted directly on the chart as arrows. Even 
considering that the system cannot trade for you yet, it has already become an important aide and generates 
signals that can be used as recommendations in conducting operations. All that the user has to do is “bite the 
bullet” and, regardless of what happens in the market and what doubts or thoughts enter your mind, the trading 
strategy silently and patiently gives signals for trading following only logic and common sense, removing the 
emotional impact of the market on the user during trading. 

 
 You see the signals in the form of arrows reflecting the trading strategy that was launched. Then by 
right-clicking the mouse, bring up the context menu directly on the chart, find the entry “Attached Trading 
Systems” and select it. This is the second way to launch and manage the TS. 

 
 

 
Chart EURUSD 1H ->right button ->  

->Attached Trading Systems 
 
 

 The “Trading System” window appears and lets the user manage the Trading Strategies. 
 
  

The “Trading System” window allows you only to manage the strategy, and only for the given currency 
pair and chart time period from which this window was opened.  In this case, it is only the EURUSD 1H chart. It 
should be noted that the above also refers to the way the chart is presented: whether BID or ASK prices were 
used to plot the charts. 
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 In the main row, you see a list of Trading Strategies that were launched or are ready to be launched on 
this chart. 
 
  
 
 
 
 The headings “Instrument,” “Interval” and “Bid/Ask” display the currency pair, the chart interval and the 
mode of reflection of the price chart, from which this window was opened. 
 
 The “Name” column displays the names of trading systems available for launch on this chart. The 
“Status” column shows the system’s state at any given time. 
  

At present, the “Status” column may display only a few symbols combinations. 
 

The symbols  or  indicate whether the system is running in the automatic trading mode or not.  In 
other words, it shows whether the system is set to make trades according to the conditions set in the strategy’s 
formula. 

 
The symbols  or   indicate to the user whether the trading strategy brings the signals that were 

specified to the chart field or not (if such signals had been described in the formula). 
 
Accordingly: 

 
- This example shows that the attached Trading Strategy has been launched for operation, makes 
calculations and all symbols and actions are switched on, if prescribed for, except for the 
management of trading operations in the automated mode. This is the main mode for launching the 

system and projecting it to the price chart of a currency pair. It makes sense to use this mode for TS testing or 
considering its signals as recommendations for market operations that are conducted manually. All systems 
are launched in this mode by default. 
 

- The Trading Strategy here has been launched, calculations are made, and all signals and 
operations that are described in its formula are switched on and displayed. The System itself 
manages trading operations in the automated mode. This is the mode for launching the system to 

conduct trading operations automatically. This mode should be used to test the TS in a VTtrader demo 
account.  
 

 Just try to remember a simple rule: 
 

The symbols   or  display the launch/shut down of the TS for trading and relate only to a specific 
currency pair and chart period.  
  
 Let’s assume that we open two windows containing the charts of the same currency pair and the same 
time period (EUR/USD 1H). The TS that was launched will operate only on this currency pair and the time 
period selected However, the signals from the system may be brought, if necessary, to any open window for 
the same currency pair and the same interval (EUR/USD 1H), or to both windows at the same time. There, you 
may create any indicators and oscillators. They would not interfere at all with the operation of the TS. 
 
 So, the system may be attached to any chart interval of the currency pair and in this state it can be 
launched for automated trading, as well as displaying symbols for recommendations, but in both cases the 
system continues to operate in background mode. Everything depends on what the user wants to do. If the 
user wants to apply the strategy’s signals as recommendations for his own actions, he may attach the strategy 
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to the chart and only make it bring the signals to a chart. If the user has trust in the attached strategy, or 
satisfied with the results that were produced by its signals, he/she may turn on the strategy’s automated mode 
and monitor it from time to time. 

  
For that purpose, the right side of the “Trading System” window contains a 

number of buttons. 
 

The “Add” button brings up the “Trading Systems Select” 
window. It displays the list of Trading Strategies, and by 

highlighting an item in the list and clicking the “Add” button, you will be able to add 
it to a chart. 
 
 
 
 
 
 

 
 
The “Edit” button brings up the “Trading System Properties” window that is used to edit the 
Trading System’s properties which were set by default when it was created. We will not go into 

detail at this point. The peculiarities will be discussed in a separate chapter. Note that when the “Complete Bar” 
formula calculation mode is turned on, one may change only the number of lots in each transaction, and any 
other parameters would not make any sense in that case.  
 
The “Delete” button deletes the Trading Strategy selected by the cursor. To be precise, the TS is not actually 
removed from the VTtrader platform, but simply unattached from the chart and deleted from the list of systems 
attached to a given currency pair. It does not matter what state the system was in. All signals disappear, and 
no actions are taken. If at this point, the TS had opened positions, they would have to be closed manually by 
the user.  
 

The “Start/Stop” button turns the TS on/off in the automated mode. That is confirmed by the 

symbols  or  in the line of the attached system of the same window. The symbol   
indicates the state of readiness for launch, and the symbol  will inform the user that the system is currently 
running in automated mode. Therefore, as soon as the condition that was specified in the Strategy’s formula 
becomes true, the appropriate action will be taken. 
  

 Select the line containing the name of the Trading Strategy with the mouse and click the 
“Start/Stop” button. You can see how the symbol changes. Since you have not yet created or specified the 
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conditions for opening positions in this TS, no changes will be made to your deposit and no transactions will be 
made. 
 

-> Trading Systems (Chart EURUSD 1H) -> Moving Average of Relative Strength System -> 
-> Start/Stop -> Start/Stop -> Start/Stop -> Start/Stop 

 
If you highlight the TS and click the “View Events” button, the “Trading System Events” 
window will open. This window shows the exact date and time the signal was triggered.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

You should recall that during the development of the strategy’s formula, we entered the names of 
variables “Long” and “Short” and attached certain actions to them. You can see on the above example exactly 
when the system received signals in relation to the values of the price chart. The readings are listed in their 
entirety, from the very first to the very last of the data displayed on the screen. By default, it is set to 500 bar 
values and can be adjusted from the “VT Navigator” window by following the following path. 

 
 VT Navigator-> Options -> Properties ->General -> General Properties -> History Length ->500 

 
 As a side note, if your computer’s processor is slow or you have numerous applications running, you 
should not increase the number of bars on the charts indefinitely. We recommend that this value be set at 250, 
which is usually more than enough for the trader’s purposes. In any case, you can always switch to a larger 
scale chart of the currency pair and observe price history for a longer period. 
  

The “Params Enabled” button opens the “Trading System Events” window, which enables the 
user to assign or cancel certain actions to the variables that were specified in the “Output” 

window.  
 
The checked boxes show what actions are to be taken 
by the specific parameters while implementing the 
condition assigned to a given variable. If an action of 
this system is not required, it can be removed without 
changing the formula itself by clearing the check box 
next to the parameter and its action. In the same 
manner, you can also designate a new action. 
However, we do not recommend doing this unless 
absolutely necessary.  Before doing so, the user 
would have to select the properties of an action for a 
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given parameter when creating or editing a trading system based on the objectives of his/her Trading Strategy. 
Otherwise, the actions will be applied by default. 
 
 Try to check and uncheck the box next to the “Long” parameter. You will see blue arrows pointed up 
appearing and disappearing from the chart, as per the action you attached to the “Long” parameter.  
 

Trading System Events -> Long -> Graphic -> Off  -> Ok ->… 
Trading System Events -> Params Enable -> Long -> Graphic -> On -> Ok ->… 

 
Click the “Close” button to close the “Trading Systems” window.  
 

 
 

It is not recommended to simultaneously launch multiple Trading Systems arbitrarily because the 
system makes the appropriate calculations in accordance with its formula, regardless of whether the signals 
are generated or whether the system is operational in trading mode. Running multiple Trading Systems can 
overload your computer.  
 
 In the next section of the manual we will learn how to optimize the “Moving Average of Relative 
Strength System” Trading Strategy. 
 
 If you experienced any difficulties in understanding these concepts, you should review the previous 
sections of the manual. 
 
 

Step 5. Further Improvement of the Trading Strategy . 
 

Designating Actions for Conducting Trading Transact ions to the Conditions 
 

 
 In case you logged off from the VTtrader platform, launch it again in demo mode. Open the EUR/USD 
1H chart and create the “Moving Average of Relative Strength Index” indicator by taking the steps we 
discussed earlier:  
 

Chart EUR/USD 1H -> right-click -> Add Studies -> Moving Average of Relative Strength Index -> OK … 
 

Follow this path to make sure that there are no Trading Systems currently attached: 
 

VT Navigator -> Tools ->Active Trading Systems Summary 
. 

We will now enable the TS to open and close positions, and also make it possible to change the entry 
parameters and use the Alerts as a way to check that they are correct. 
 
 Even the best trading systems in the world know nothing about the specific character of the Market, and 
they certainly do not know how to operate on their own. The only language they understand is logic and 
mathematics. However, the developers of the VTtrader platform designed the systems to issue an order to 
open a position in the appropriate direction. The TS can issue orders only for Buy or Sell transactions. It is very 
important to understand that in order to close an existing Buy position, the system must issue a Sell order 
based on a “true” condition. Another Sell order may be issued from the same spot, if this was provided for in 
the Trading Strategy formula.  
 
 Similarly, in order to close a Sell position and simultaneously open a Buy position, two Buy orders will 
be required: one to liquidate the previously opened Sell position and the other to open a new Buy position.  
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Let us examine the Trading Strategy that we developed. Its formula is shown below: 

……………………………………………………………………………………. 
 

 {Relative Strength Index} 
 
 RSI_r:= (CLOSE - ref(CLOSE,-1));  
 RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) /                 
 Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
 RS:= 100-(100/(1+rsi_rs)); 
 
 {Moving Average of Relative Strength Index} 
 
 MA1:=MOV (RS, 10, E); 
 MA2:=MOV (RS, 30, E); 
 
 {Signal Long and Short} 
 
 Long:= CROSS (MA1, MA2); 
 Short:= CROSS (MA2, MA1); 

……………………………………………………………………………………. 
 
 
The first component is as follows:  
 
{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1)); 
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) / 
Wilders(if(rsi_r<0,Abs(rsi_r),0),14); 
RS:= 100-(100/(1+rsi_rs)); 
 
It calculates the Relative Strength Index indicator for the Trading System. 
 
Here, we have the second component:   
 
{Moving Average of Relative Strength Index} 
 
 MA1:=MOV (RS, 10, E); 
 MA2:=MOV (RS, 30, E); 
 
It calculates two moving averages – MA1 with a 10 day interval and MA2 with a 30 day interval from the 

“Relative Strength Index” indicator. 
 
 And this third component makes it possible to estimate the MA1 and MA2 crossovers: 
 
  {Signal Long and Short} 

 
 Long:= CROSS (MA1, MA2); 
 Short:= CROSS (MA2, MA1); 
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When the MA1 moving average exceeds the MA2, the short-term variable “Long” becomes equal to 1, 
and in accordance with the associated action, it displays a symbol (blue upward pointed arrow) on the price 
chart.  
 

When the MA1 moving average is less than the MA2, the short-term variable “Short” becomes equal to 
1, and in accordance with the attached action, it displays a symbol (red arrow pointed downward) on the price 
chart. 

 
 
We will now see what happens if, in addition to displaying the symbol on the price chart, the “Long” and 

“Short” variables were set to actually place trades in the direction of the arrows on the price chart. 
 
 
Let us assign the “Long” variable to open Buy positions and the “Short” variable to open Sell positions. 

Please, examine carefully the “Moving Average of Relative Strength Index” indicator located under the price 
line: 

 
 
 
 
 
 
 
 
 
 
 
 
 
When the red MA1 moving average crossed above the blue MA2 moving average line, the “Long” 

parameter was “true” for a short time (i.e. equal to 1, and equal to 0 the rest of the time), and the order to open 
Buy position was issued. 

 
 When the red MA1 line crossed below the blue MA2 line, the Short parameter was briefly “true” (equal 

to 1, and equal to 0 the rest of the time). The order to open a Sell position would have been issued, but would 
only close the previously opened Buy position (i.e. become a counter position) and not open a new Sell 
position. This would run counter the correct operation of the Trading Strategy. 

 
So for now, let us leave the Long and Short variables alone. They fully meet their requirements. Let us 

create new variables that are able to track open and close positions in one direction on our conditions and by 
themselves. 

 
Follow the path below. Open the Trading Strategies Builder module, find the “Moving Average of 

Relative Strength System” that you have created according to this manual, and open it for further editing. Move 
to the “Formula” tab: 

 
VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Formula... 
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Now we will create variables, the “true” condition of which would trigger an order for opening the Buy 
position (we will call it OpenBuy), and that position would be closed (we will call it CloseBuy) by issuing an 
order to open a Sell position, that would play the role of the closing position for the previous Buy position, 
which was opened in accordance with OpenBuy. 

 
OpenBuy:= condition ; {order to open  BUY position}  
CloseBuy:= condition ; {order to open SELL position, will close the position opened in accordance with  

OpenBuy} 
 
Accordingly, we will also create variables, the “true” condition of which would trigger the order to open a 

Sell position (we will call it OpenSell), and it would be closed (CloseSell) by issuing an order to open a Buy 
position, that would play the role of the closing position to the previous Sell position, which was opened in 
accordance with OpenSell. 

 
OpenSell:= condition ; {order to open  SELL position}  
CloseSell:= condition ; {order to open  BUY position, will close the Buy position opened in accordance 

with OpenBuy} 
 
Because the condition to open a position is the “true” state defined by the “Long” parameter, and vice-

versa for the “Short” parameter, the variables can be estimated by the following: 
 
OpenBuy:= Long ; {order to open  BUY position}  
CloseBuy:= Short ; {order to open  SELL position that would close the  Buy position opened in 

accordance with  OpenBuy} 
 
And:  
 
OpenSell:= Short ; {order to open a SELL position}  
CloseSell:= Long ; {order to open BUY position that would close  Buy position opened in accordance 

with  OpenBuy} 
 

Take a look at the following formula, which are the opening position components: 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:= Long ;  
CloseBuy:= Short ; 
 
{OpenSell and CloseSell} 

 
OpenSell:= Short ;  
CloseSell:= Long ;  
 
When one of the conditions for the “Long” or “Short” variables (as an example, we will choose “Long”), 

is “true” and MA1 crosses above MA2, because Long:= CROSS (MA1, MA2), the OpenBuy and CloseSell 
variables (as you can see in the opening positions component) also become equal to 1, since OpenBuy:= Long  
and CloseSell:= Long.   

 
 In this case, in accordance with the action associated with these variables, each will issue an order to 

open a Buy position. One of these positions is designed to close a previously opened Sell position.  
 
 But suppose there is no previously opened Sell position. The result would differ from what we would 

have expected to see. Two positions in the same direction (in this case for Buy) would be opened. 
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It is necessary to properly define the conditions for variables, for which an action will be associated to 

conduct transactions. 
       
In this case: 
 
OpenBuy:= Long ; will be implemented only if “Long” is “true”.  
CloseBuy:= must be “true” not only when “Short” is “true”, but also when a position was opened through 

the OpenBuy variable. In other words, the OpenBuy and CloseBuy variables must be linked to each other in 
some way. The CloseBuy variable operates only in order to close positions that were previously opened by 
OpenBuy, and for that purpose CloseBuy receives a signal from OpenBuy. 

 
Consequently, the reverse is true:  
 
OpenSell:= Short ; will be implemented only if Short is “true”. As for:   
CloseSell:= must be true not only when “Long” is “true”, but also when a position was opened through 

the OpenClose variable. In other words, the OpenSell and CloseSell variables must be linked to each other in 
some way. The CloseSell variable operates only in order to close positions that were previously opened by 
OpenSell, and for that purpose CloseSell receives a signal from OpenSell. 

 
It should be clear that for the Trading Strategy to function properly, we must link the OpenBuy variable 

with CloseBuy. CloseBuy can be implemented only if OpenBuy was previously “true” and, accordingly, an 
action was taken. 

 
 Respectively, we must link the OpenSell variable with CloseSell. CloseSell can be implemented only if 

OpenSell was previously “true” and, accordingly, an action was taken. 
 
In order to link the two conditions to each other, we recommend using the EventCount(“param”) 

function, which will return the number of “true” occurrences of the condition of the parameter, as in the 
following examples. They are not case sensitive. 

 
EventCount(“OpenBuy”) – will return the number of “true” states for the OpenBuy parameter 

. 
EventCount(“CloseBuy”)– will return the number of “true” states for the CloseBuy parameter 
 
EventCount(“OpenSell”) – will return the number of “true” states for the OpenSell parameter 
 
EventCount(“CloseSell”)– will return the number of “true” states for the CloseSell parameter 
 
 
We can now introduce the following changes into the opening positions component: 
 
 {OpenBuy and CloseBuy} 
 
OpenBuy:= Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:= Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:= Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
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Look at the line with the OpenBuy condition. It says that the OpenBuy variable may be equal to 1, and 
this means that the opening of a Buy position will occur only if MA1 crosses above MA2 (Long=1). The number 
of “true” states for opening BUY positions must be equal to the number of closed ones through the CloseBuy 
variable.  

 
In other words, if there were Buy positions opened through the OpenBuy variable, and if they are all 

closed through the CloseBuy variable, it will become “true” when MA1 crosses MA2. A new position in the 
same direction cannot be opened, if there is at least one position in that direction. 

 
The line CloseBuy says that the Buy position may be closed only if MA1 crosses below MA2 (Short=1), 

and there should be a position created through the OpenBuy variable 
[eventCount('OpenBuy')>eventCount('CloseBuy')]. 

 
The OpenSell variable may be equal to 1, and this means that the opening of the Sell position will occur 

only if MA1 crosses below MA2 (Short=1). The number of “true” occurrences triggering the opening of Sell 
positions must be equal to the number of their closings through the CloseSell variable.  

 
So, if there were Sell positions opened through the OpenSell variable, and if they are all now closed 

through the CloseSell variable, only when the MA1 and MA2 crossover occurs will it become “true”. A new 
position in the same direction cannot be opened if at least one position in that direction exists. 

 
The line CloseSell says that the closing of the Sell position may occur only if the MA1 crosses above 

MA2 (Long=1), but there should also be a position opened through the OpenSell variable 
(eventCount('OpenSell')>eventCount('CloseSell')). 

 
So now we are able to control the opening and closing of positions in the same direction. We can safely 

conclude that the opening positions component’s code is correct. 
 
We recommend using such a template for controlling positions when proprietary Trading Strategies are 

developed. To make your Trading System easier to understand while it is being tested, it is recommended that 
you assign one action to each condition. In this case, it is easier to search the TS code for mistakes. For 
example, we may specify that if a certain condition is met, the symbol will be displayed and simultaneously a 
position will be opened. Also, two variables may be designated, and the same condition may be assigned to 
them. In the first case the symbol will be displayed only when the strategy operates in the Automated Trading 
mode and the operation performed; in the second case it will be always be displayed when the condition is met 
that is included into the formula for processing orders. 

Check and correct, if necessary, the code of the Trading Strategy’s formula (you can simply copy it from 
this document and replace the existing code) in the field under the Formula tab:  

 
 VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Formula... 
 

Now it should read as follows: 
 

……………………………………………………………………………………. 
 

{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
RS:= 100-(100/(1+rsi_rs)); 
 



www.vtsystems.com 

 

28

{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, 10, E); 
MA2:=MOV (RS, 30, E); 
 
{Signal Long and Short} 
 
Long:= CROSS (MA1, MA2); 
Short:= CROSS (MA2, MA1); 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:= Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:= Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:= Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
 

……………………………………………………………………………………. 
 
Move now to the “Output” tab of the “Studies Editor” window, and follow the path below to assign the 

required actions to the variables. 
For the OpenBuy variable, include the function of conducting trading operations: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->OpenBuy-> 
->Name->Open Buy-> 
->Description->Open Position Buy-> 
->Trading Enabled->ON… 
 
Then select their properties under the “Trading” tab. Specify the type of Buy operation: 
 
Output Variable Properties->Trading->BUY… 
 
Also specify the number of confirmations of this condition at each new price tick, if the “Each Tick” 

mode was switched on under the “Studies” tab of the “Studies Editor” panel, so that an accidental price spike 
will not trigger the order for closing the position when calculating the Strategy’s formula.  

 
->Event Count->5… 
 
We recommend that you avoid lowering this parameter. If this reading for accepting the “true” state of a 

condition is not available during the formation of a bar, the order will be implemented upon the bar’s 
completion, if the condition triggering a given action becomes “true.” This parameter is adjusted in a separate 
manner during the testing stage of the Trading Strategy for a given instrument, based on its volatility at 
different time intervals.  

 
Click the “OK” button. The actions for the OpenBuy variable are adjusted. 
 
Keep the “Studies Editor” window open. In a similar manner, adjust the actions for other variables of the 

Strategy: 
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For the CloseBuy variable, follow this path: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->CloseBuy-> 
->Name->Close Buy-> 
->Description->Close Position Buy-> 
->Trading Enabled->ON… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Output Variable Properties->Trading->SELL-> 
->Event Count->5… 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

Click “OK”:           ->Ok 
 
 
For the OpenSell variable: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->OpenSell-> 
->Name->Open Sell-> 
->Description->Open Position Sell-> 
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->Trading Enabled->ON… 
 
->Output Variable Properties->Trading->SELL-> 
->Event Count->5… ->OK 
 
For the CloseSell variable: 
 
Studies Editor ->Output->New->Output Variable Properties->Name-> 
->VarName ->CloseSell-> 
->Name->Close Sell-> 
->Description->Close Position Sell-> 
->Trading Enabled->ON… 
 
->Output Variable Properties->Trading->BUY-> 
->Event Count->5… ->OK 
 
Do not close the “Studies Editor” window yet. Carefully check the syntax of all the parameters. Very 

often, the most common mistake can be found in the syntax.  
 
The Trading Strategy is almost ready for implementation. But there are still a few more steps to be 

taken. At the beginning of this manual, we mentioned that it would be advantageous to be able to adjust the 
parameters of entry data when the Strategy is displayed on the chart, without having to change the formula 
itself. We should now finish with that issue. This will turn your first Trading Strategy into a fully functioning 
product that meets the requirements of the savviest traders.  

 
Step 6. How to designate and correct variable entry  parameters of the Trading Strategy 

 
Based on the task set before us by the author of the Trading Strategy, the only values that can be 

changed are: the period of the Relative Strength Index that is the foundation of the TS, and periods of MA1 and 
MA2 moving averages (their crossover is a signal to conduct operations). The type of moving averages 
remains the same. They should all be exponential. 

 
You should now be on the “Output” tab of the “Studies Editor” window.   

 
VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Output... 
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Click on the “Formula” tab and look at the following component: 
 
{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),14) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),14);  
RS:= 100-(100/(1+rsi_rs)); 
 
And: 
 
{Moving Average of Relative Strength Index} 
MA1:=MOV (RS, 10, E); 
MA2:=MOV (RS, 30, E); 
 
You will notice that we have specified that the Strategy’s formula will include RSI with the period of 14 

days, and moving averages MA1 and MA2 with 10 and 30 day periods respectively. We will now assign new 
variables for the periods that could be changed in the process of the implementation of the TS. For the RSI, 
we’ll call the variable PerRSI (abbrev. from Period RSI), and for MA1 and MA2 - PerMA1 and PerMA2 
respectively. Make the necessary changes in these components. They should now read like the following: 

 
{Relative Strength Index} 

 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),PerRSI) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),PerRSI);  
RS:= 100-(100/(1+rsi_rs)); 

 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, PerMA1, E); 
MA2:=MOV (RS, PerMA2, E); 

Move to the “Input” tab and specify the new 
variables. 

 
For PerRSI: 
 
Studies Editor ->Input->New->Name->no name->PerRSI-> 
->Display Name-> Period RSI -> 
->Type ->integer -> 
->Default ->14 
 
For PerMA1:  
 
Studies Editor ->Input->New->Name->no name->PerMA1I-> 
->Display Name-> Period MA1 -> 
->Type ->integer -> 
->Default ->10 
 
For PerMA2:  
 
Studies Editor ->Input->New->Name->no name->PerMA1I-> 
->Display Name-> Period MA2 -> 
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->Type ->integer -> 
->Default ->30 
 
Now everything is ready. Assuming no mistakes were made in the syntax of the variables, the “OK” 

button will close the “Studies Editor” window. Otherwise, an error message is generated. If that happens, find 
and correct the mistake. 

 
The aforementioned actions make it possible for the user, when activating the Strategy, to change the 

periods of the RSI and the MA1 and MA2 moving averages. The “Ok” button lets you move to the “Edit Trading 
System” window. Use the “Close” button to close it. 

 
Apply the Strategy directly to the price chart. 
 

Chart EURUSD 1H -> right Bottom -> Add Trading System -> Moving Average of Relative Strength System -> 
one click mouse.. 

 
In the pop-up window, you will see the names assigned to the variables (PerRSI – Period RSI, PerMA1- 

Period MA1, PerMA2- Period MA2). They are ready to be changed from the default settings (14, 10, 30 
respectively). 

 
 
 
 
 
  

 
 
 
 
 
 

 
Close this window using the “Cancel” button. 
 
Let us make ourselves clear. Imagine what would happen if, in the above window, the user specifies 

Period MA1 as equal to 30, and Period MA2 equal to 10, or just changes the MA2 period to a value less than 
period MA1. This may happen in real life and at the worst time possible. Such a move would completely ruin 
the notion of the Trading Strategy. That is why it is necessary to either exclude such a possibility altogether or, 
even better, introduce the necessary controls. That is exactly what we are going to do. 

 
Bring up your Strategy for editing and go to the “Formula” tab. 

 
VT Navigator -> Tools -> Trading Systems->Edit Trading Systems-> Moving Average of Relative Strength 

System ->Edit ->Studies Editor ->Formula.. 
 
Add a new variable to the strategy. Let us call it “Err.” Create the following condition for it. Let it assume 

the “true” value when there is an error in the parameter data entered, specifically: 
 
 
{Control Error} 
 
Err:= (PerMA1=0 or PerMA2=0 or PerRSI=0) or (PerMA1>=PerMA2); 
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In other words, the entered parameters should not equal 0 (PerMA1=0 or PerMA2=0 or PerRSI=0), the 
MA1 period should be less than the MA2 period (PerMA1>PerMA2), and those periods should not be the same 
(PerMA1=PerMA2). If these conditions are not met, the Error variable becomes equal to 1. 
 
 Because the Strategy should not take action under these circumstances, we will block the conditions 
with the Error variable. If there is a mistake in the parameter data entered, Err=1, and the “not Err” script will 
equal zero in this case. And, consequently, when there is no error, Err=0, and “not Err” will return to 1.  
 

We will now change the Strategy’s formula. The final version of the TS formula is as specified below 
(you may copy this if you wish): 

 
 

……………………………………………………………………………………. 
 
 

{Control Error} 
 
Err:= (PerMA1=0 or PerMA2=0 or PerRSI=0) or (PerMA1>=PerMA2); 
 
{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),PerRSI) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),PerRSI);  
RS:= 100-(100/(1+rsi_rs)); 
 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, PerMA1, E); 
MA2:=MOV (RS, PerMA2, E); 
 
{Signal Long and Short} 
 
Long:=not Err and CROSS (MA1, MA2); 
Short:=not Err and CROSS (MA2, MA1); 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:=not Err and Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:=not Err and Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=not Err and Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:=not Err and Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
 
 

By changing the Strategy’s formula, you have corrected it and made it ready for implementation. 
  

There is one item that is still open for correction 
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Move to the “Output” tab and set the System so that if the entry parameter data are wrong, a sound file 
could be simultaneously played along with the error message appearing on the screen. The operations are as 
follows: 
 

For the Error variable: 
 
 

Studies Editor ->Output->New->Output Variable   
Properties->Name->… 
 
->VarName ->Error-> 
->Name-> Mistake of entrance parameters -> 
->Description-> Mistake of entrance            parameters-> 
->Alerts Enabled->ON… 

 
->Output Variable Properties->Alerts-> 
->Alerts Message ->Error: Mistake of entrance parameters-> 
->Alert Sound File ->Choose the sound or melody that you want played.   
 
 
  

 
 
 

 
 
 
 

Press “Ok.” -> Ok 
 
 
 There is one final addition. Move to the “Studies” tab of the “Studies Editor” window, and insert the 
following line into the “Label Mask” field: 
 

MA RSS (%PerRSI%, %PerMA1%, %PerMA2%) 
 
This will make it possible later on to observe what values of the entry parameters are used when the 

Trading Strategy is launched for operation. Using the “Ok” and “Close” buttons, close all windows. Your first 
Trading Strategy is now complete. Restart the VTtrader application and verify that you are in demo mode. 
Open any chart on a short interval (5m). Launch the Trading Strategy in any way that is convenient. Everything 
should function properly. Good luck in trading! 
 

Characteristics of the Modes of Operation of Tradin g Strategies 
and Formulas for Decision-Making in Trading 

 
        Each bar in a bar chart consists of large number of ticks. At any time each one of them may cause the 
condition to become equal to 1 (true). That triggers the action attached to that condition. The bars within that 
period are used only to calculate the price movement history. Each bar can be described with several 
parameters: Date, Time, and Prices (High, Low, Opening and Closing).  
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         The closing price is particularly important for any decision made by the Trading System (TS). These 
decisions are based on historical price data. The data that is entered in accordance with the conditions 
described in the TS reflect the bars’ Highs, Lows, Closing and Opening Prices. 

 
         The user may enter the TS in the "Complete Bar" section. In this case the Trading Strategy awaits the 
completion of the bar chart for the period that was used to launch the TS. The decision whether a condition is 
true or false is made only after this period has ended. If the condition is true the attached action or actions are 
taken. 
 

At present time the Trading System may operate in two modes.   
 

The Modes of Launching the TS 
 

The trading systems in VTtrader have 2 modes of ope ration: 
 
1. Recommendation-only mode: This is the default mode that trading systems are added to your 

chart in. In this mode VTtrader will take no auto-trade actions even if you have the "trading" parameters 
enabled for your auto-trade variables. 

 
2. Auto-trade mode: This is the mode that allows VTtrader to execute BUY/SELL market orders based 

on your trading system's generated signals. Auto-trading actions are ONLY executed at the close of bar - not 
intrabar. However, alerts (signals) will still be generated in realtime (intrabar). 

 
You can verify what mode your trading system is running in using a few different methods... 
 
The first method is the right-click with the mouse on the trading system's label. Next to the "start/stop" 

menu option you will see a small icon. If the icon looks like a pause button [ || ] the trading system is in 
recommendation-only mode. However, if the icon looks like a play button [ > ] the trading system is in auto-
trading mode and will execute trade action if your trading variables are checkmarked (active) in the trading 
system's parameters. 

 
The second method of verifying what mode your trading system(s) is running in is to use the "Running 

Trading Systems" option in the Navigator Window>Tools menu. This popup window will show you a summary 
list of all trading systems you have attached to charts within VTtrader. Next to each trading system name you 
will see the same small icon (either [ || ] or [ > ]) notifying you of what mode each trading system is operating in. 

 
Another quick way to see if a trading system is running in auto-trade mode while attached to a chart is to first 
look at the VTtrader tray icon located down next to your PC clock. If there is a flashing red dollar sign that 
means there is a trading system running in auto-trade mode somewhere within VTtrader (* note: there is an 
outstanding bug with the red dollar sign whereas if a trading system is deleted from a chart without being 
stopped first when running in auto-trade mode, the flashing dollar sign will continue to flash even though no 
trading system is still running in auto-trade mode; this will be fixed in a future release of VTtrader). Next, look at 
the blue window bar at the top of each chart window... the charts with attached trading systems running in 
auto-trade mode will display "Running Trading System" in that blue bar. 
 
        Each of the two modes may be activated separately in the "Complete Bar" mode. This is confirmed by 
the appropriate signals in the Trading System’s properties window attached to the price chart. To access it, 
follow the following path: 
 

Chart ->right click ->  
->Attached Trading Systems -> Trading System - >Edit 

        
        A third option is to use both modes together. 
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         The user must be able to distinguish between these two modes. The Recommendations Mode applies 
only to the price chart to which the Trading Strategy is attached. Depending on the user’s preferences, the 
Recommendations Mode may be displayed on any price chart in the research field. The Automated Trading 
mode, on the other hand, applies both to the currency pair and the price chart interval, and also to the entire 
VT Spot trading platform and, in particular, to the user’s account that is used for transactions. 

 
It is very important to note the following:  
 
            Only one Trading System may be launched in the Automated Trading mode at any one time for each 
account and currency pair, regardless of the time interval. The system will issue a warning and cancel any 
attempt to launch the same or different Trading Strategy on the same account and currency pair, unless the 
original strategy is shut down. 
 
         In the Recommendations mode an unlimited number of strategies may be launched at any time. The 
user may choose any price chart and time interval for a currency pair without any reference to a particular 
account. The user will only have to change the properties of the signals displaying the attached strategies by 
altering the systems, so that their signals could be distinguished. 
 
         When any Trading Strategy is attached to the chart, this would be signaled by the text “Trading System 
Running” in the top panel of that chart window.  
 

New Possibilities of the Trading System Builder 
 

After reading this manual, you may notice certain changes in the newest release of VTtrader  in the 
windows of the Trading Strategies Builder, which provide additional possibilities for creating Trading Systems. 
However, this will in no way influence the systems that you had previously constructed, including the system 
created previously according to this manual. 

 
What is the main difference? Based on users’ requests, both internal and external improvements have 

been made. Internal improvements include the extension of the syntax of the language of VTtrader, and the 
formulas of trading strategies’ signals, and other improvements related to the internal nucleus of the Trading 
Platform. External improvements include additional bookmarks, fields and switches that make the Strategy that 
you create more responsive to the requirements of the most demanding user. 

 
So, let’s start from the beginning. Earlier in the manual, based on an example, you created your first 

Trading Strategy Moving Average of Relative Strength System. 
 
Here we will make step-by-step improvements to this strategy. Please follow closely all instructions 

while we give the necessary clarifications. 
 
Open the EURUSD 60m chart to full screen and remove all indicators and oscillators that were 

previously brought up as well as all other chart drawings. Let the chart be clear. 
 

Then open the Trading Strategies editor. Inside the window, find and select Moving Average of Relative 
Strength System Trading System created with the rules of this manual and press “Edit” to bring it up for editing. 

 
 

 
 
Edit Trading Systems-> Moving Average of 

Relative Strength System -> Edit ->… 
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Move to the “Formula” bookmark. 
 

…->Studies Editor ->Formula.. 
 

 
 
 
 
 

 
 

 
 
Insert a new block into the System’s code. Explanations for these actions will be given later. Do not 

forget that this manual’s Strategy example is used solely to demonstrate the possibilities of the Trading 
Strategy Builder.   

 
{Trend Up and Down} 
 
UpTrend:=not Err and MA1>MA2; 
DownTrend:=not Err and MA1<MA2; 
 
If you carefully examine the block, you will see that “not Err” (taken from the above main part of the 

manual) allows us to check whether the entered parameters of the Moving Averages and RSI period are 
correct, and the UpTrend variable is equal to 1 (or to a true meaning), when MA1 is greater than MA2, or equal 
to 0 (or false meaning) when this condition is not met. 

 
The DownTrend variable will be equal to 1 (or have true meaning) when MA1 is less than MA2, and to 0 

(or false meaning) when this condition is not met. 
 
Later, a certain action of the Trading System will be assigned to these variables. There can be any 

number of variables and we recommend using your computer to full capacity and assigning a variable to each 
desired action. This will allow more flexibility in managing the TS when they are ready, and during the testing 
phase to control all variables and correct possible mistakes. Later we shall demonstrate this. 

     
Now you may copy the final code of the Strategy from the text of the manual and insert it into the 

“Formula” graph instead of the existing one.  
 
Here’s the code: 
 
{Beginning of script…} 
 
{Control Error} 
 
Err:= (PerMA1=0 or PerMA2=0 or PerRSI=0) or (PerMA1>=PerMA2); 
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{Relative Strength Index} 
 
RSI_r:= (CLOSE - ref(CLOSE,-1));  
RSI_rs:= Wilders(if(rsi_r>0,rsi_r,0),PerRSI) /                 
Wilders(if(rsi_r<0,Abs(rsi_r),0),PerRSI);  
RS:= 100-(100/(1+rsi_rs)); 
 
{Moving Average of Relative Strength Index} 
 
MA1:=MOV (RS, PerMA1, E); 
MA2:=MOV (RS, PerMA2, E); 
 
{Signal Long and Short} 
 
Long:=not Err and CROSS (MA1, MA2); 
Short:=not Err and CROSS (MA2, MA1); 
 
{Trend Up and Down} 
 
UpTrend:=not Err and MA1>MA2; 
DownTrend:=not Err and MA1<MA2; 
 
{OpenBuy and CloseBuy} 
 
OpenBuy:=not Err and Long and (eventCount('OpenBuy')= eventCount('CloseBuy')); 
CloseBuy:=not Err and Short and (eventCount('OpenBuy')>eventCount('CloseBuy')); 
 
{OpenSell and CloseSell} 
 
OpenSell:=not Err and Short and (eventCount('OpenSell')= eventCount('CloseSell')); 
CloseSell:=not Err and Long and (eventCount('OpenSell')>eventCount('CloseSell')); 
 
 
{End of script…} 
 

 
To check whether the entered code is 

correct you may press “OK”, and in case 
there is no error report, again bring up the TS 
for editing. If the system issues a warning, 
press the “Cancel” button in the report 
window, and carefully edit the Strategy’s 
code. 

Move to the “Output” bookmark. 
 

 
…->Studies Editor ->Output.. 

 
 

Operating according to the chains below specify new variables and assign to them the required actions of the 
Trading Strategy. You will be given necessary explanations. 
 
For the Long variable: 
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 Studies Editor -> OutPut -> Long ->Edit->Output Variable… 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Here you can see that there are new bookmarks and a new set of switches called “Trends” and 
“Indicator Output” that were not mentioned earlier in this manual. We remind you that if the switch is on (box is 
checked) a given variable is assigned an action, and if you move to a corresponding bookmark you can tune 
the characteristics of this action. Now we shall employ these features to demonstrate the possibilities of the 
system. 

 
For the Long variable turn on the “Indicator Output” switch: 
 

 
 
Output Variable ->Name-> Indicator Output ->ON… 
 
Move to the “Indicator Output” bookmark and select the properties: 
 

Output Variable -> Indicator Output ->… 
 
 

…-> Color -> Blue ->… 
 

…-> Line Width -> 0… 
 

…-> Line Style -> default… 
 

…-> Placement -> Addition  Frame1… 
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A few things should be explained here. For the Long variable we specified that in addition to a sign 
brought up to the chart (an upward blue arrow in accordance with the manual) the price movement chart will 
also show the values of this variable as a separate indicator, specifically a blue (Color) line (Line Style) of 
certain width (Line Width). But where will it be placed? This will be indicated by a property such as 
“Placement,” where Price Frame will bring the line to the price chart, and Addition Frame will create a separate 
frame under the price movement chart and place the line inside it. Conversely, in this release of the system two 
additional frames can be used to reflect the values of variables in a certain manner. The user must decide for 
himself whether it is necessary to place anything inside the frames depending on the output values of the 
variable and the scale of the vertical line of measurement. Any number of output values of the variables may 
be placed inside one frame, using different ways to mark them on the screen.   

 
Similarly, edit the Short variable. 
 
Studies Editor -> OutPut -> Short ->Edit->Output Variable… 
 
For the Short variable turn on the “Indicator Output” switch: 
 
Output Variable ->Name-> Indicator Output ->ON… 
 
Move to “Indicator Output” bookmark and select properties: 
 
Output Variable -> Indicator Output 
… -> Color -> Red ->… 
…-> Line Width -> 0… 
…-> Line Style -> default… 
…-> Placement -> Addition Frame1… 
 
For the Short variable we specified that in addition to the sign brought up to the chart (downward red 

arrow according to the manual), the price movement chart will show the values of this variable as a separate 
indicator. Specifically, it will be a red (Color) line (Line Style) of certain width (Line Width), placed into the same 
frame, where the values of the Long variable are indicated. In other words, the values of the Long and Short 
variables will be shown in the same frame and will differ in color. 

 
Do not complete system editing yet. Input two new variables that we specified in the TS formula. 
The UpTrend variable: 
 
Studies Editor ->OutPut->New->Output Variable Properties->Name->… 

 
Specify the name of the variable.  
 
…->VarName ->UpTrend->… 
…->Name-> UpTrend ->… 
 
Turn on the actions for it.  

 
…->Trends Enable->ON… 
…->Indicator OutPut->ON… 
 

Set the properties on the corresponding bookmarks. 
 
On the “Indicator Output” bookmark: 
 
Output Variable -> Indicator Output 
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… -> Color -> Blue ->… 
…-> Line Width -> 0… 
…-> Line Style -> default… 
…-> Placement -> Addition Frame2… 
 
In such a manner we will place the values of the UpTrend variable in a separate frame (Frame 2). 
 
On the “Trends” bookmark:  

 
Output Variable -> Trends->… 
 
Turn on the graphic indicator of the true/false condition of the variable. 
 
… -> Display Vertical Lines -> On ->… 
 
 
Specify the color and the way the zone of the true condition of the 

variable will be reflected. 
 
…-> BackGround -> Blue… 
…-> Pattern -> (choose type)  

Choose the symbol to be shown inside the zone  
 

…-> Label -> 
Select Symbol -> 

    -> (choose Symbol –Bull)->… 
 

and the color  
 
 

…-> Label Color -> Black  
 
 
 
Press “OK.”  
 
 
 
 
 
 
 
 
 
 
At this point, by the above actions, we assured that while the strategy is operational the values of the 

UpTrend variable, regardless of the Long and Short variables ( they are brought up in a separate frame - 
Frame 1), will be shown in a separate frame - Frame 2 – as a stand-alone indicator, but aside from this in case 
of the true condition (0 and 1, respectively, indicate the false and true condition) this zone will be marked by 
vertical lines with color identification from the bottom of the chart. Soon we shall demonstrate the results. 

 
Insert the variable for DownTrend and assign its functionality. 
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Studies Editor ->OutPut->New->Output Variable Properties->Name->… 
 

 
Specify the name of the variable.  
 
…->VarName ->DownTrend->… 
…->Name-> DownTrend ->… 
 
Enable actions for that variable.  

 
…->Trends Enable->ON… 
…->Indicator OutPut->ON… 
 

Select properties for them on corresponding bookmarks. 
 
On “Indicator Output” bookmark: 
 
Output Variable -> Indicator Output 
… -> Color -> RED ->… 
…-> Line Width -> 0… 
…-> Line Style -> default… 
…-> Placement -> Addition Frame2… 
 

This way we will place the values of the DownTrend variable into a separate frame (Frame 2) together 
with the UpTrend variable: 

 
On the “Trends” bookmark:  

 
Output Variable -> Trends->… 
 
Turn on the display of the true/false condition of the variable. 
 
… -> Display Vertical Lines -> On ->… 
 

Specify color and 
display of the zone of 
true/false condition of the 
variable. 

 
…-> BackGround -> 

RED… 
…-> Pattern -> 

(choose type)  
 
 
 

 
 
 
 
 
 
Choose the symbol for the zone:  
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…-> Label -> Select Symbol -> 
    -> (choose Symbol- Bear)->… 

 
and its color 
 

…-> Label Color -> Black  
 
 
Press “OK”.  
 
By way of the above actions we assured that whenever the strategy is operational the chart will reflect 

the values of the DownTrend variable regardless of the Long and Short variables (they are also shown in a 
separate frame - Frame 1) inside a separate frame - Frame 2 – as a separate indicator together with the 
UpTrend variable, but aside from that if the condition is true (0 and 1, respectively, stand for false and true 
condition) a zone will be marked by vertical lines and highlighted from the bottom of the chart.  

 
Now everything is ready for further steps. Follow the chain: 
 
Studies Editor ->OutPut->OK->… 
 
Provided there is no error message close the trading strategies editor. 

 
Edit Trading Systems ->Close->…. 
 
 
Using the context menu and the commands that you know, build the “Moving Average of Relative 

Strength Index” indicator directly from the price chart (EURUSD 60m, bid). 
 

Chart EURUSD 1H -> right Bottom -> Add Studies -> Moving Average of Relative Strength Index -> OK … 
 

And launch the Moving Average of Relative Strength System strategy that you have created and edited 
in accordance with these Additions to the trading manual. 

 
 

Chart EURUSD 1H -> right Bottom -> Add Trading Systems -> Moving Average of Relative Strength System -
>(I Agree) ->OK … 

 
 

 
 
 
 
 
 
 
 
 
 
If you have followed the above recommendations the price chart will show the EURUSD 60m price 

movement, below it in a separate frame the Moving Average of Relative Strength Index indicator that we built 
that is used as a foundation by the attached Moving Average of Relative Strength System trading strategy, and 
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at the bottom - Frame1 containing the values of the Long and Short variables that are calculated using the 
following formula: 

  
{Signal Long and Short} 
 
Long:=not Err and CROSS (MA1, MA2);  
Short:=not Err and CROSS (MA2, MA1);  
 
And below inside Frame2 the values of the UpTrend and DownTrend variables, calculated as follows: 
 
{Trend Up and Down} 
 
UpTrend:=not Err and MA1>MA2;  
DownTrend:=not Err and MA1<MA2; 
 
It is important to understand that it is not necessary to place these exact values of the variables on the 

price movement chart together with the display of the trading strategy. In this manual that is done only with the 
purpose of demonstrating the possibilities of the Trading Systems Builder and show the differences between 
the comparison functions and “cross” language functions, since this particular question is frequently raised by 
the users. Such approach allows you to monitor the value of any variable in the TS formula by placing it on the 
screen together with the attached strategy.   

 
Note that the “cross” function is displayed in impulses while the comparison function is more 

comprehensive, i.e. remains true until the values of the variables become false. 
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Examine the above screenshot and the developed trading strategy. If some elements do not seem 
logical, re-read this manual 

 
Annex: How the Trailing Stop System Works and How to Apply It 

 
Most of the users are probably familiar with the concept of Trailing Stop and, moreover, have used this 

technique in their trading.  
 
Many traders believe that trailing stops can provide guaranteed insurance against losses in the market. 

In our view, this is not always the case. Truly, trailing stops are convenient instruments, but they require that 
the user fully understands how it works and uses it with discretion. 

 
 
 
 
 

 
 
 
 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Trailing Stop system allows the user to trail the market with a protective set-up (Stop Loss) from 

the level where it was set (Set Stop Loss) for an open position (Open Buy) and at a certain distance from the 
price (N).  
 
  On the chart above it can be seen the Trailing Stop level meticulously follows the closing price of the 
bar at a distance of N, ignoring occasional price spikes, if the price moves in the direction of the open position: 
 

(Close-Trailing Stop) > N . 
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 Also, it does not change the level when the price movement is less than the set N value:  

 
(Close-Trailing Stop) < N  

 
The Trailing Stop is ready at any moment to close a position and take profit, if the market turns around. 

 
 What distinguishes a savvy trader is his ability to determine the right N value for a specific chart scale. If 
the trader plans to trade on a tick-by-tick chart, then the Trading System must be launched on a tick-by-tick 
chart.  
 

The Trailing Stop Loss, supplied with the VTtrader System is based on tracking the price level and 
allows the user by way of experimenting and analyzing to determine the right N value. The indicator plots the 
line showing the best Stop level for a given N value.  

 
 
 
 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
It is recommended that you carefully study this indicator. The logic of this indicator can be used to 

create proprietary systems, designed both to monitor profits and control losses. 
 
Different ideas have been studied in conjuncture with the concept of Trailing Stop. In this manual we 

will explain the logical formula incorporated into the Trailing Stop System Trading Strategy. 
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In order for the system to operate, the user must have an open position, e.g. BUY on a Demo, to which 
he wishes to attach a Trailing Stop System.  Please, the standard means to bring up the VT-Trailing Stop 
System Trading Strategy: 

 
  

 
Chart (Chart EURUSD 1H) -> right Bottom -> 

Add Trading Systems -> VT-Trailing Stop System 
->…  

 
 
 
 
 
 

 
…-> read the text and click “I Agree” ->OK … 

 
A panel will open up where you will enter the strategy’s parameters:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

In the space “Stop Price for Open Position” enter the initial desirable stop level (Set Stop Loss) for your 
open position, using a quote from the chart:  
 

 
 

 -> Stop Price for Open Position -> … (quotes) 
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*if you set the initial level above (in this particular case - versus below for the SELL position) than the market price 
at the moment when the system is launched, than in any case the TS shall operate only from this level. In this case the 
Trading Strategy may be used not only as a Trailing Stop, but also as a Limit Profit. If this level is surpassed the TS shall 
begin monitoring the level as a Stop from the current level, but it will not “allow” the price beyond its level. In other words, 
if the price moves further, it will be trailed, if not it will be stopped. 
 
 

In the “Open Position Direction” field choose the direction of your open position from the list. If the 
system issues an order it will be in the opposite direction:  
 

-> Open Position Direction -> … (Buy or Sell) 
 

 
 
 
 
 
 
 

 In the field “Stop Step” (N-Pips Trailing Stop) specify the value that will be the distance, at which the 
Trailing Stop will follow the price.  
 

 
 

-> Stop Step -> … (delta quotes) 
 
 
 

 
Please be aware that for the example for EUR (GBP, CHF, etc.) Stop Step = 0.0050 is equal to 50 pips, 

whereas for JPY 50 pips will transfer into 0,50.  
 
Press “OK.”   
 
The chart will display the results of the calculations performed by the Trading Strategy. The plotted line 

moves from the level, at which the Stop was set, to the zone in the bottom part of the chart.  
 
After the properties are set do not forget to launc h the strategy for execution. The system will 

take action only once. To use it further it has to be restarted. 
 
 
 
 
 
 
 
 

THANK YOU FOR TAKING THE TIME TO READ THIS MANUAL. IF YOU REQUIRE ASSISTANCE WITH 
ANY OF THE FEATURES AND/OR FUNCTIONS DESCRIBED, PLE ASE FEEL FREE TO CONTACT US. 

 
General Help Info: http://www.vtsystems.com/en/help/  
Online Support Forums: http://forum.vtsystems.com  
Email Tech Support: techsupport@vtsystems.com  


